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Preface

A brief attempt at writing the history of the project

The PSKmail project was started by Rein Couperus, PA0R early 2005. The baby steps were taken 
with a modification of gMFSK, the mode of choice was PSK63 and traffic was handled by the one 
and only server (PI4TUE) that existed. Soon another server joined the effort, SM0RWO in 
Stockholm, and suddenly the project had “multiple” users (two) and had to evolve. For a time there 
was only the server in Stockholm and two clients (PA0R and SM0RWO) and the project made 
necessary adjustments for the hf environment. Soon more servers started to appear, 
IS0GRB/Roberto, added a much needed server in the Mediterranean. Then more and more servers 
joined, such as WB5CON/Fred and DL9YCS/Jörg. The Intermar group then followed with several 
servers. At the start only email traffic was handled and, as stated earlier, only done so using PSK63. 
Soon more services were added, web browsing was one of those. One of the more important 
additions was APRS.

Traffic was handled nicely by PSK63 but yours truly, SM0RWO, felt the need for speed and noticed 
that the Fldigi project offered PSK125. Quickly Fldigi was integrated and PSK125 was the mode of 
choice for a long time. That urge for faster modes resulted in a move to PSK250 which is an 
excellent mode, it is of course faster and thus wider (abt 250 Hz). Wait a second, we almost always 
use 500 Hz filters in our rigs. Why not aim for a 500 Hz wide mode then? That mode was PSK500 
and we moved there around summer of 2009.

Lengthy discussions within the group resulted in the consensus that it was time to break free from 
the chains of the old PSK31 keyboard to keyboard concept. PSK31 was indeed a fine idea but it had 
to make some sacrifices in order to reach its goal of being a suitable successor to rtty. Processing 
times could not be long, it had to deliver data pretty much in a similar way that the rtty operators 
were used to and one apparent problem was a lack of forward error control. A missing character 
here and there can mostly be handled by the human brain, not so by a computer with checksum 
control of received frames.
VK2ETA, John Douyere, made it his task to create the more robust modes where FEC and an 
interleaver net was added to the PSK modes, the new mode is designated as PSKRobust 
500/250/125 and has been a real success. In fact PSK robust 500 has been the default EU mode ever 
since.

Mode profiles were added by Rein, these control the server speed and mode that can be adapted by 
the server. The server can move a connected session to a faster mode when the conditions are right 
and can of course select a more robust mode when the conditions deteriorate.

While writing this  asymmetric linkup has been implemented. By that we refer to a connection that 
does not use the same mode and speed in both directions. For instance its now possible to have a 
weak client use a slow and robust mode while the server uses a very fast one. The mode scope now 
ranges from THOR4 to PSK500, using PSK, MFSK and THOR modes to cater for differing adverse 
conditions, including polar flutter, multipath, Doppler and QRN.
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What is PSKmail?

PSKmail is a system that uses data modes to enable clients to access both the internet and to 
communicate with other pskmail clients. Data modes are used over a suitable radio, mostly it's a hf 
radio but higher frequencies are also in use.  

Just saying internet access could mean that the system should support a whole range of services, 
and indeed it does just that: 

1. Messaging 
◦ Handles the users regular email account, including gmail etc. 
◦ For emergencies its even possible to handle messaging off the internet (the whole 

internet could be down, messaging works anyway) 
2. Web browsing, fetch and read any web page 
3. Twitter, send and read tweets (via identi.ca)
4. File up and download 
5. Supports APRS including position reports, messages and short emails. 
6. Supports map clients like Xastir and Uiview

But, that's just part of what's there now. Servers can also fetch your weather report periodically, 
show you where the nearest camp site is and tell what other users are nearby and so on... 

So, what makes PSKmail special?

PSKmail is designed with the mobile/portable (maritime too) ham in mind. There is no big, power 
hungry and expensive modem to carry along. PSKmail is designed to use your PC soundcard as 
modem, right now the digital modem program Fldigi is what is being used for that very purpose.

A mobile/portable station is mostly not what we sometimes refer to as a “big gun”, antennas and 
power output tend to be on the modest side. With that in mind PSKmail uses bandwidth efficient 
modes, hardly ever wider than 500 Hz (for frequencies > 30 MHz that may of course be the case).

Wide data modes require a better signal to noise ratio than narrow ones, PSKmail is even able to 
adapt the speed and the mode so that the client can select a really narrow and efficient mode. Then 
again as the signal to noise ratio increases or the QRM goes away it will use wider and faster 
modes.

PSKmail network topology is flexible:

1. Clients can connect each other using ARQ, for chat or message transfer

2. Clients can connect to servers, which are gateways to the internet

3. Clients can send each other messages in unconnected mode

4. Clients can send APRS message and position beacons to the APRS backbone through the 
servers

5. Clients also contain a passive Igate, which can gateway messages and posits to APRS

6. Clients contain a telnet port where you can connect a map application like Xastir or Uiview

1. The system also includes a telnet client to connect to telnet services on the internet or on a 
LAN connected  to the server
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In summary, what is pskmail?

The main characteristics of PSKmail can be summed up as:

● A semi duplex ARQ Chat client capable of transferring files

● A full fledged solution for HF APRS, including integration with the map clients

● An internet connection that can be used where there is no internet connection. Such as from 
a boat at sea or a cottage somewhere or on expedition or...

● Narrow, efficient, data modes are used. Thus enabling even the most modest setup.

● Servers on short wave provide long range connectivity

● No expensive and bulky modem, all you need is a PC, a transceiver and an antenna

● Available on multiple operating systems (Linux and Windows, MacOS and FreeBSD)

What about security in pskmail?

Starting with jPSKmail-1.2, the link is protected with a password. If no password is set, the link is 
insecure. To use the POP3 mail agent on the pskmail server it must know where to get your mail. 
Unlike other HF mail systems, the pskmail server does not store your mail, it has to get it from the 
mailbox at your ISP. The server uses a database to store your POP data, viz. Pop server, userid and 
pop password. The database can be updated from the client, by sending a record to the server with 
the 'update server' command. To make sure only the server gets the data the client sends the record 
using a cooky. By setting a link password via the Preferences dialog you make sure somebody else 
using your callsign is unable to get your mail. You have to do this only once for every server (unless 
the database gets lost...). From jPSKmail-1.5.6 and server 1.5.1 you can also erase the record from 
the server.

Data (mail, files, web pages) are NOT encrypted on the link, but it is possible to send them 
compressed (zipped) to speed up transfers.
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Installation and getting started

To use PSKmail you need: 

1. A ham radio license 

2. An HF transceiver with a working antenna solution, for boats that may include an antenna 
tuner and an insulated backstay or a whip antenna. 

3. A computer running Linux, Mac OS or Windows. 

◦ FreeBSD should also be fine but we lack test reports there. 

4. An interface for connecting the computer soundcard to the hf transceiver 

5. A narrow filter (500 Hz) in the transceiver is highly recommended. A bandpass dsp may also 
be very nice but is normally not a replacement for a real filter. 

To install and use the jPSKmail client you will need: 

1. A java runtime environment. 

◦ For Linux and MacOS you should be able to get that through your software 
distribution system (software update). 

◦ For all others, windows, its here: http://java.com/en/download/manual.jsp 

2. A suitable modem, we use Fldigi for that now. 

◦ Fldigi can be found here: http://www.w1hkj.com/Fldigi.html

Install procedure

The install procedure is in principle the same for all operating systems, there are subtle differences 
and they will be shown further below. But, the steps are:

1. Get and install Fldigi

2. Install jPSKmail

3. Make sure you have a java runtime environment

4. Launch the actual installer

5. Configure Fldigi and the jPSKmail client

Optional aprs mapping client

APRS contains geographical information such as positions of boats, vehicles etc. Its very nice to see 
that information on top of a map, that is why an aprs mapping client can connect to jpskmail and 
use that as a local internet server. JPSKmail outputs APRS information to that client. To connect a 
map application to pskmail use tcp port 8063.

8

http://java.com/en/download/manual.jsp
http://www.w1hkj.com/Fldigi.html


Installation Instructions for RXTX

jPSKmail needs a JAVA Communication API to communicate with a GPS via the serial line (RS232 
or USB), that library is the rxtx package. These steps are only necessary if you intend to actually  
use a GPS.

Windows 98/NT/2000/XP:

For installing the RXTX package you will find the necessary dll and jar files within the directory 
where you installed jPSKmail.

Installation procedure:

•  copy rxtxSerial.dll to %JAVA_HOME%\bin,
(%JAVA_HOME% is the folder where JRE is installed on your system; e.g. c:\Program 
Files\Java\j2re1.4.1_01)

•  copy RXTXcomm.jar to %JAVA_HOME%\lib\ext

Linux:

If you are using Ubuntu you may very easily take care of that by installing “librxtx-java” using 
synaptic or from a terminal with “sudo apt-get install librxtx-java”.

Others, manual procedure

For others, linux other than ubuntu, the simple procedure that follows involves copying files from 
the folder where jPSKmail was installed. 

Installation procedure:

•  copy librxtxSerial.so to %JAVA_HOME%/jre/lib/i386,
(%JAVA_HOME% is the folder where JRE is installed on your system; e.g. 
/usr/local/j2sdk1.4.1_01)

•  copy RXTXcomm.jar to %JAVA_HOME%/jre/lib/ext
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Hardware selection

Transceiver

There are many kinds of transceivers in use, many work really well with pskmail. Selecting a 
transceiver can be tricky and is of course guided by many factors. A few words of advice may be 
helpful for the beginner anyway. 

A good transceiver should have an optimized digital mode, a mode where a narrow filter can be 
used for better reception. Adding a 500 Hz narrow filter is a very good way to enhance the S/N ratio 
on receive and may be the difference between a working and a non working connection.

Older transceivers may lack a dedicated digital mode and may require special handling in order to 
employ a narrow filter. One way around that is to use a split and listen in cw, with filter, and 
transmit in USB. That method may also require tweaking the rig BFO for cw. A memory for all of 
that is then useful.

As some of the modes (markedly the slower MFSK modes) used require precise TX and RX 
frequencies, choose a transceiver which is capable of doing that... 

A server that intends to use some kind of scanning will require a computer control connector, such 
as CI-V or CAT or whatever hamlib will support. Computer control is not necessary for a client at 
the moment but could be useful for handling the PTT.

 Soundcard interface

A soundcard interface is used to connect the computer to the transceiver. It may in theory be 
possible to connect straight lines between sound in/out and the microphone connector on the 
transceiver but that method has so many drawbacks that it is not recommended. A soundcard 
interface will provide isolation between the pc and the radio, it will normally be attached to the 
transceiver data connector and that helps keep the receive level correct. Its also much better to have 
the interface control the keying of the PTT instead of using a VOX. In all, please do consider using 
a soundcard interface.

Antenna

This is a favourite subject among radio amateurs and I suppose whatever I write here will be subject 
to discussion :-). Anyway, an old truth may help: big antennas are good antennas and small antennas 
are only small. You are more than welcome to discuss antenna choice on the pskmail mailing list, 
many experienced hams should be ready to help.

For a sailing boat a classical antenna is to use an insulated backstay with a tuner mounted close to 
that wire.  
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Setting up Fldigi

PSKMail needs a modem to work, that modem is Fldigi and setting it up properly is absolutely 
crucial. General Fldigi setup is best described by the help provided by the Fldigi project. But, there 
are a few things that need to be taken care of for pskmail.

The necessary settings can be found through the menu configure->modems, the tab Mail can be 
found  through the Misc->Pskmail tab 

Carrier frequency (Hz)

Carrier frequency is the audio frequency you wish to use with your transceiver. Many use 1000 Hz 
here as that makes frequency calculation easy. For instance if the server uses the assigned frequency 
10147 and you enter 1000 Hz then the dial should say 10146 (upper sideband). It is important that 
the carrier frequency is in the center of your narrow filter. E.g., if the center of your dsp filter in an 
IC756 is on 1500 Hz, set your carrier frequency to 1500 Hz.

AFC range (Hz)

Its good to have the client and server stay on the same frequency, the modems will try to find each 
other by adjusting the frequency (AFC). That is why we limit how far away that AFC will be able to 
move the frequency. AFC range is the setting to take care of, a 50 Hz limit should be fine for wide 
modes. Narrow modes such as PSK 63 will require a more narrow setting, say 10 Hz.

Reset to Carrier and Report ARQ frames average S/N

Reset to Carrier kicks in when there is no signal present and forces the audio frequency back to the 
set carrier frequency, it is recommended to enable that. Report ARQ frames MUST be set.

These settings are only valid when Fldigi is connected to the pskmail client. If Fldigi drifts away 
from the frequency and seems to ignore what you have entered here then perhaps the connection 
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between the client and the modem was not successful. The initialization will only take place when 
the client or server connects to the modem (Fldigi). This means you should always start Fldigi 
prior to starting the pskmail client or server.

Please ensure:
•That Fldigi is started before the server or client is started.

•If Fldigi is restarted for any reason, the server or client must also be restarted.

RS ID

The next to take care of is RS ID settings, which is very simple. Just uncheck everything in the RS 
ID frame, illustration of that below:

It is advantageous to disable RSID receive and transmit for modes which pskmail is not using, that 
makes sure  fldigi does not switch to an invalid mode. 
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Also enable the XMLRPC port in fldigi, which is used for rig control and S/N reporting on the 
client:

When Fldigi works you can try to send some pings on one of the server frequencies, if your signal 
is decoded by a server then you will get a reply. 

In some configurations Fldigi will not send the last character of a frame (<EOT>. When this is the 
case you can add some random characters to the frame in the Modem Tab of the Edit>Preferences 
screen. Once you get answers from a server the preparations are done. 

You could ask another station on frequency to take a look at the transmitted signal, make sure it is 
not too wide. The TX audio should just touch the ALC. You are now ready to join the fun. 

But, you will of course read through the rest of the manual first?
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User Interface tour
The jPSKmail application has an interface with some permanently visible parts and some that are 
grouped and accessible through tabs. Upon starting the application it will display the main window.

The main tabs and their purpose are:

•Terminal, shows the error corrected exchange with other stations.
Its not like the modem monitor further down in that only session text is displayed.

•Email, where you can send and receive emails.

•Files, where you can upload and download files to a server or to another client.

•APRS, the center of the APRS action including positions, messages, beacons etc.
Many will have that tab page up whenever not connected to a server.

•Modem, shows S/N, mode and lots of modem statistics, also includes statistics on what servers can be used.

•Igate, shows all relevant information on what beacons have been relayed to the internet.

•Rigctl, allows access to the scanner and summoning functions.
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The main user interface is divided into several sections, the sections have different main purpose 
and they are as follows:

Main menu 

Buttons for important
functions on the selected tab.

Tab area, contents
depend upon selected tab

Grouping tabs

Modem monitor area, 
always visible

Application status,
outgoing text,
Server selector etc.

But, before we go into detail about the main user interface we need to dive into configuring and 
setting up the client. 
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Preferences window

User data

The first thing to do is to set up your preferences. The preference window can be reached through 
the menu, choose the “preferences” item and then “edit”

The fields on the first tab page need editing, the fields are:

1. Callsign 
Please use capitals for your call, and don't use additions like ZL/ or /M.
SSID's (-2, -15) are allowed.

Your email settings are stored at the server using the callsign as key. If you wish to check several 
email accounts then you could tie them to an ssid each, I use no ssid for my primary email account 
and -2 for gmail. Just type in the first, update the server and repeat the procedure for the next 
account.

2. Link to
Call of the server or client you want to connect, normally the one you can hear best.

There is a list of servers on the pskmail wiki, server operators are requested to keep that list 
up to date: http://pskmail.wikispaces.com/PSKmailservers

The server call can be changed with the server selector at the bottom of the page.

3. Minute
The minute the client beacons. The server has 1 minute time slots with a 5 minute period.  
The beacon minute runs from 0...4. It is used to make sure you don't tx on top of someone  
else. Also some servers are scanning several frequencies, and you can choose the channel  
this way.

4. Latitude
In decimal degrees.... in case you do not use a gps unit. You may leave this field empty if you 
intend to use the devices tab to declare how a gps is connected. North is positive.
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5. Longitude 
In decimal degrees.... in case you do not use a gps unit may leave this field empty if you  
intend to use the devices tab to declare how a gps is connected. East is positive.

6. Set link password 

Sending the link password to the server

Connect to the server. After sending your mail user record,

Write  :SETPASSWORD <enter>

Beacon minute and server channel
A server sysop may want to cover several frequencies, using only one transceiver. By switching between 
several bands its possible to have both local coverage on 80 meters and DX on higher bands (provided the 
antenna is capable of that). PSKMail uses a five minute continuous scan loop where servers can monitor one 
frequency per minute. The beacon minute setting in the client controls what minute to send aprs position 
beacons, a correct value there is then the minute that the server you want to link to listens to the frequency 
you are tuned to. The server scans during minute 0-4 and can use one default mode and frequency per 
minute. The scan loop goes on and on so minute 5 of the hour is minute 0 in the loop and so on.

Let's say that the server scans 80,40,30,20 and 17 meters. It listens during one minute on each frequency and 
all the servers update their scan table on the wiki, that way you can find what frequency and mode the server 
is on. So, if you would like to try 30 meters then the server in the example is there during minute 2. So, you 
should set minute 2  on the client and it will handle beacons etc. on the proper minute.

This means its important to sync your pc clock using ntp or manually. There are numerous ways about this, 
from GPS (GPS time is visible beneath the position on the aprs tab if you are connected to a GPS). At this 
time jPSKmail will not update the system time, the reason for  that is that it requires different user privileges 
on different operating systems.

During a connected session, while the Monitor function is active, and also during reception of a Bulletin, 
scanning is halted and the client will remain on the channel..

Choosing the appropriate modes

Receiving conditions can be completely different at server and client. Often the server runs more power than 
the client, and the client's antenna is often too small, badly tuned and in the middle of an electro-magnetic 
field we usually call 'local QRM'. The latter is typical for camp sites with lots of RV's, or boats in a harbour. 
That is why PSKmail can use asymmetric link control, providing different modes for uplink and downlink. 
Link control for both up- and downlink is done by the server. Mode changing is established using RSID, a 
separate super robust MFSK signal telling the modem at the other end of the link which mode to listen in. 
Proper reception of RSID signalling is critical to efficient arq operation, and it is the lower limit of what can 
be achieved on a link. It is important to choose modes which are capable of connecting to the other end of 
the link. A good choice for the client mode is the default listening mode of the server (PSK500R or PSK250), 
THOR22. or MFSK16. Once the connect has been established, the server will take over mode control, and 
will use the proper modes for up- and downlink channels. If you are not sure your frequency is exact, you 
can try THOR22, which is largely insensitive to small frequency offsets. The new Connect window (1.5.6) 
allows you to set different RX and TX modes for the connect sequence. 

Please be aware that slow modes need more time to get a connect packet through to a server. It pays to  
start connecting at the beginning of the minute. The newly introduced THOR4 mode will even need 90  
seconds, so it can only be used for connecting if the server actually listens in THOR4 for minimum 2  
minutes!!
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Setting the Mode table and the default mode

Starting with version 1.4.0, the client can set a custom mode table, which is sent to the server during 
the connect sequence. The mode table can be set using the Preferences->Modes dialogue:

By hitting the Fix list button you fix the mode table. Set the Default mode with the “Def.mode” 
spinner and push OK to store the modes list....

Setting operating modes
The new (1.5.6) Connect window lets you choose which server to connect, and which modes to use for TX 
and RX during the connect sequence.

As soon as the session is established, the other side will control 
your mode.

When idle, and not monitoring, the client will switch back to 
the default mode automatically.

Email settings

Edit->Preferences->Mail options: 

1. Pop host 
The name of your pop server, e.g. pop.myisp.com. If you intend to use a gmail account then  
enter pop.gmail.com here.

2. Pop User 
Your POP userid. For gmail it is your full account name (including @gmail.com or  
@your_domain.com) 

3. Pop Password 
Your POP password
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4. Return address 
When someone wants to respond to your email then the reply will be sent to this address, if  
you want to receive the answer when away then use the address you can check. When 
sending emails an smtp server checks whether your return address is valid. This is also  
necessary for sending one-line emails via APRS. A server which does not have your return 
address may be unable to send your email. For gmail this is your full account name 
(including @gmail.com or @your_domain.com).

It is now also possible to use a different return address for every mail, which is  
convenient when e.g. you are on a boat with several people

5. Compressed OTA
Check this to enable compressed email handling and web page downloads over the air.  
Compressed means that emails  and web pages are transferred as binary zipped files, this  
can speed up the transfer by a factor of 2x.

Configuration Terminal tab, connected operation (ARQ)

Edit->Preferences->configuration - 

1. Log file 

2. Max retries
Maximum number of retries in TTY (chat) mode

3. Idle time
Max. time (seconds) the client waits for the end of a session when idle (in chat mode only)

4. TX delay
Time delay in seconds before the TX starts sending. Normally 0.

5. Beacon second 
You can fine tune the time your beacon is sent by changing this value.
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6. Offset minute
Deprecated

7. DCD hang time 
The DCD hang time sets the sensitivity of the RX to noise on the channel.
A  value of 1..2 is adequate in most cases. A value of 0 effectively switches DCD off. If the  
value is too high, the delay can interfere with the beacon timing of the system. If there is a  
lot of noise on the channel (random characters received) the client may not be able to send 
a status packet in time...  During a connected session DCD is not active...!

Devices

This tab controls external devices and connections. At the moment that means an external GPS and 
the internal APRS server for external mapping clients. The GPS is used  for updated position 
beaconing and also GPS time is fetched and shown on the client. The internal APRS server is used 
from an aprs mapping client, for instance xastir. APRS data is fed to the mapping client so that 
geographical aprs information can be viewed on top of a map.

1.GPS is connected
If the rxtx libs are installed then this checkbox can be used. Select it to have the client look for, and 
use, a gps.

2.Use gpsd 
Gpsd is a gps data server which is only available in Linux. It allows several programs to use the  
data of the gps unit. Uncheck this if you are running windows. jPSKmail uses the new gpsd  
protocol, so you must use gpsd version > 2.9.0.

3.Serial port

Where is the GPS connected? The client will attempt to fetch the systems serial ports and in the  
example above the client is running on linux. Other systems will refer to the ports by other names  
(such as COM1 etc.).

4.Speed
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Standard NMEA speed is usually 4800 bps but if other speeds are used then just select the correct  
one here.

5.APRS Server port enabled

jPSKmail can act as your own internet APRS server. Just point an APRS mapping client to  
localhost, when jPSKmail and the mapping client are installed on the same computer that is. 

6. Port number

Connect the APRS client to localhost and the port noted here.

Modem

This tab controls the connection to the modem (Fldigi). In most cases they will coexist on the same 
computer but its perfectly fine to have them run on separate computers on a local area network.

1.IP Address
Where is the modem, if on the same PC then enter localhost or 127.0.0.1, if it is somewhere on the 
local area network (or on the internet) then enter the IP address of that PC. If you would like to run 
fldigi on one PC (in the shack for instance) and jPSKmail on another (in the garden perhaps) then 
have a look at the next section of the manual where that is described (next page).

2.IP Port
This is the port that the modem (Fldigi) uses and the one the client will try to connect to. Standard 
now is port number 7322.

3.Frame preamble
Some setups have reported trouble with incomplete frames being transmitted. If the start of the 
frame is missing then its possible to add extra characters to transmit before the start of the frame. In 
most cases this will be empty.

4.Frame postamble
Works kind of like preamble, only after the frame. The characters in this field will be sent after the 
frame.

21



Running fldigi and jPSKmail on separate PC's

You cannot be in the shack all the time... I wanted to use jpskmail from the garden 
table, without moving the K3 and the antennas... Fortunately jpskmail allows you to 
connect to a remote instance of fldigi. To do this do the following:

5.Start fldigi with the right command line additions:  

--arq-server-address HOSTNAME (The default is: 127.0.0.1 )

--arq-server-port PORT (The default is: 7322) 

--xmlrpc-server-address HOSTNAME (The default is: 127.0.0.1 )

--xmlrpc-server-port PORT (The default is: 7362)

6.Go to jpskmail edit->preferences->modem and fill in the host name 

7.Hit the OK button...

8.Restart jpskmail

jpskmail will now connect to the remote instance of fldigi. in my case it is running on 
an eeePC 701.
When I minimize fldigi the machine only needs a few Watts, and I combine it with a
file server function...

I can now operate jpskmail anywhere around the house as long as I am within range 
of the wifi access point.
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Main user interface, tabs

Terminal tab, connected operation (ARQ)

With the terminal tab you can start a connected session with the server. 

1. Hit the Connect Button or goto Files->Connections->Connect
The Connect button will give you a connect window where you can choose the modes.

2. Wait until server acks and starts the session. The Connect Status will change from 
"Listening" to "SERVERCALL", and the small coloured indicator on the bottom right will 
turn green...  PSKmail uses a 3-way handshake for connect, you know for sure the connect 
was successful when you receive the 'greeting message' from the server.

3. You can now issue any command the server will recognize. The most important functions 
can be reached with a button or via the menu.

4. To end the session hit the QUIT button (same as Connect). 

5. If the server does not receive this command, you can abort the session by 

hitting the Abort button. It is courteous to wait for the QUIT to disconnect, in 

that case the server will not send polls until it times out... 
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With the abort button you can close a 
connection one-sided. The client sends an abort frame to the server. If the server does not notice 
that, it will continue polling until it times out. It is not regarded very courteous to do this. 

With the Pos. button you can manually send an APRS Posit packet. Any server receiving it will send 
a QSL packet. You do not have to be connected for this.

Terminal tab, chat mode (ARQ)

To use the chat (client to client) mode, just put the callsign of the station you want to call into the 
server selector and hit the connect button. Since jPSKmail 0.8.5 automatic mode control is 
implemented. 
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For File upload go to the Files Tab, and hit the Upload button. After choosing a file to upload, the 
client will ask you what the addressee for the file is. jPSKmail is being prepared for Delay Tolerant 
Networking in future...

 

Composing an email

There are two basic ways to create and transmit emails from jPSKmail:

•Proper emails with custom subject and possibly an attachment

•Very short emails, called pskaprs emails, with fixed subject and no attachment

Preparing an email

The email editor can be reached with the New button on the Email tab. The email editor is rather 
simple, there are fields for address, copy, subject and message content.
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•To
Enter the addressee email address here. Multiple recipients can be entered, its important to then 
separate them with a comma like: “user1@domain.com, user2@domain.com”

By clicking on the TO-button a window showing the address book contacts is shown and those can 
be used to address he message. Just select the desired contact on the left hand side and push add for 
the TO or Copy fields. When done just push the close button and the addresses will be displayed on 
the new email.

•Copy

Please note that this functionality is not yet included in the server. In time it will be used to add 
copy addressees to your message, much like any other email client is able to.
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•Subject
Well, its the message subject, keeping it somewhat short is good

•Message body
The message text, the actual content of the message

•Add attachment
If you wish to add an attachment then browse for it after clicking this button. The attachment will 
be compressed and packed into the message so please bear in mind that it needs to be small. 
I would not add attachments bigger than a few kb.
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Sending email, connected

When connected the “Send” button on the email tab can be used to transmit your prepared messages 
in the local outbox. The Send button currently sends one email at a time so if you have two emails 
then you will have to push that button once, make sure the first email is acknowledged by the server 
(and removed from the outbox) and then repeat the procedure.

If you wish to send a certain message in the outbox first, for instance when sending a message 
addressed to a local user at the server you are currently connected to, then select that message row 
in the outbox before you push send. This will send the selected message first and bypass the 
message queue. This procedure currently only works when doing compressed email traffic.

PSKaprs emails

This is a way to transmit a short text with a fixed subject to one email address. Its done in 
unconnected mode and a server that receives it will transmit an acknowledge packet.
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This email is sent in unconnected mode so keeping the text short helps it get through to a server.

Receiving email

Received emails are added to a file called 'Inbox'. This file is in mbox format, so you can use it as a 
spool file for mail clients like Sylpheed or Thunderbird. That way the mail you receive via PSKmail 
can be integrated with your regular mail.

To read your mail using jPSKmail, 

• Connect to the server

• Go to the email tab

• Hit the QTC button, your headers will be added to the list.

• When you want to download a mail, double click on the header,it will be added to the 
Inbox. Right clicking on the header will give you a short menu (Get or open).

• When you want to read a mail, go to the Inbox tab and double click on the header. Again 
right-clicking will give you a small menu. 

Mail headers tab

This tab will display the message list fetched from your email account while connected to a pskmail 
server.  You can choose a mail for download  by right-clicking on the header. One mail at the time. 
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Mail tab buttons

The New button starts a dialog which allows composition of a new email. It is possible to add a 
small attachment (~6k) 

The QTC button requests the new mail headers from your email account. It first reads the headers 
file to see what the last header is that was downloaded. It will request only the new headers. 
You can override that behaviour by either cleaning the headers file (File->Clear->headers), or send 
'~QTC +0' To the server. 

Mail download is done by right-clicking on the header...

As soon as the download starts the progress bar will start indicating: 
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The progress bar goes to zero as soon as it reaches 100%. In monitor or Listening modes the 
progress bar shows received signal quality...

The Send button starts the upload of the first email in the Outbox. As soon as "message sent..." has 
been received from the server the email will be deleted from the Outbox. It is still available in the 
'Sent' file.

With the Delete button you can delete mails from your mailbox at the ISP. Enter the numbers of the 
mails to be deleted in the input field. You can enter more than 1 number, separated by spaces. The 
server will answer with "Mails x x deleted..." in case of success.

The numbers reflect the numbering in your ISP mailbox. After a delete mail operation you 
should clear your headers list and rebuild it so the list reflects the numbers in the ISP mailbox. 
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Files tab (connected mode)

To download a single file from the server, first enter the file name into the input field, or double 
click a file name in the 'files list', and push the download button. 
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File download is binary, compressed with gzip and base64 coded. The client decodes and unzips it 
and puts it into the Downloads directory. 

After download the file can be READ, or UPDATED. There is a file chooser dialog to make that 
easy.
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APRS tab, Unconnected Operation

Unconnected operation (like UI frames in packet radio) is done from the APRS screen.

From this screen you can organize position beacons, send aprs messages to other pskmail stations, 
to VHF units, or to the internet (Uiview, Xastir), or send APRS short emails to any email address. 

You do this via a PSKmail server which is a gateway to the internet. Servers are interconnected 
through the APRS Internet backbone (APRS-IS).

You can set the server you want to use on the servers drop list, at the bottom line of the screen.

On program start the server is loaded from the configuration file. Your pskmail client will 
automatically add more servers to the drop down list as QSL's of beacons and messages are 
received.

To be able to receive messages via a server it is necessary to be in its link table. The server link 
table makes sure messages are sent by only one server at the time. To get an entry into the link table 
you can manually send a link request (ctrl-l) to the server. The server will acknowledge the request 
and enter your call into its link table. This can also be done automatically. The client checks if the 
last link equals the preferred server and will send a new link request if necessary.  Auto-linking can 
be switched off on the APRS tab.

On the APRS tab you can set the aprs beacon icon, the beacon period and the status message. 
Beacon minute (0...4) can be set on the bottom of the screen, the beacon second on the 
Preferences->Edit->configuration tab.

It Is common practice to set the aprs beacon period to 30 minutes or 60 minutes for non-moving 
objects.

To send a position beacon manually you can use ctrl-b or the Pos button on the Terminal tab.
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To send an APRS text message just enter “CALLSIGN Texttexttext” into the text input field at the 
bottom of the screen. Use upper case for the callsign. If the callsign is known at a VHF aprs 
digipeater it will be delivered to VHF.

To send a short email enter “email@addres.xxx Texttexttext” into the text input field.

Bulletin reception mode
Whenever the client receives a bulletin (anything starting with 'ZCZC' and ending with 'NNNN'), it 
will go into bulletin mode. Several things happen in Bulletin mode:

• Frequency scanning is stopped during reception of the bulletin

• The received text will be appended to the file ~/.pskmail/Downloads/bulletins.

Bottom part of the client

Status Line, Monitor mode

The status line shows what the client is doing, 'Listening' most of the time.

When you click the Status Line it will switch to Monitor Mode. In Monitor mode incoming 
packets are shown with a time stamp, and if available the session partners...

Monitor mode stops automatically as soon as a connected session is established, or when a Bulletin 
is received. Also, Monitor Mode stops halts the frequency scanning, so you are effectively 
monitoring a single channel...

Status Indicators

There are 2 status indicators, the channel indicator and the link status indicator. The left hand one is 
the channel indicator. Colours mean:

 Grey Idle, no data 

 Yellow Data, not valid 

 Blue Data block in progress 

 Red Transmitting data 
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The right hand indicator shows link status. The colours mean:

•Green:  no errors on the link

•Yellow: rx error

•Blue: tx error

•Red: rx + tx errors

There is a slight delay, because the client does not know the link status until it receives it from the 
server. i.e. most of the time the link  indicator is 1 frame behind...

Modem tab
This tab shows some interesting facts about the current modem status. For instance it shows both 
the receive and transmit data mode, this can differ during a connected session thanks to the 
asymmetric linkup capability. S/N-value get fed back immediately and this is can/will also used to 
rank heard servers. Rx CPM shows the receive speed (Characters Per Minute).

The maximum possible speed has been measured as 1862 characters/minute (PSK500-PSK500).
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Igate Tab

The Igate can be activated on the Igate tab. When it is on, it will connect to a APRS Tier2 server.

All beacons and messages received by the Igate will be sent to the APRS-IS backbone.

Rig control tab
Rig control can be switched on via the Preferences->Edit->Rig options dialog.
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The scanning function can be switched on separately. You can also enter the default frequencies for 
the scanner. These should be entered as the center frequencies of the channel, as the scanner will 
use the Offset to calculate the VFO dial frequency. It is possible to store the frequency tables of 
known servers in the ~/.pskmail directory. The files are called SERVERCALL.chn, and contain a 
comma-separated list of frequencies (in Hz). Example for PI4TUE.chn:

29250000,10147000,10147000,10147000,18106000

Whenever CAT control is activated on Fldigi, the transceiver can be controlled from the rigctl tab.

SERVERCALL will follow the server.frequency table 

The Set button will put this into Rx Current , which is the CAT frequency in fldigi.

Rx Current  can be incremented and decremented with the '+' and '-' buttons. The transceiver will follow.

The SUMMON button is special:

If the RX Current and SERVERCALL frequencies are different, the summon button will:

• Issue a Connect Request on the SERVERCALL frequency

• Listen for the acknowledge on the RX Current frequency.

This tells the server to come to your RX Current frequency to handle the traffic.

Of course this only works if the server is configured to support summoning...

Main menu
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The main menu is divided into these main sections:

•File
General operations like connecting to a server or client, clearing lists and closing the app.

•Mode
Controls the main mode of the client and the modem mode including mode profiles for adaptive 
speed during connected sessions

•Preferences
The way to edit or save  the preferences dialog

•Mbox
The way to handle local messages on a server during connected session. This menu item is only 
visible if there is local mail waiting at the server.

•Info
Commands to send to a server during a connected session
See a detailed breakdown of Info further below.

•Identi.ca
Send and get status updates on Identi.ca

•Link
Here is where we handle the link to servers

•Map
Not currently used. An integrated map that displays aprs data has been evaluated and an even better 
one will be worked on later.

•Help
Opens the interactive help which will be created from this manual and also displays license 
information about the application.
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File 

Handles general operations like connecting, clearing lists and closing the application. 

•Connection

•Clear Inbox, or Outbox

•Clear headers

•Clear bulletins

•Show pending transactions

•Set file up/download resume policy

Mode 

Controls the main mode of the client and the modem mode including mode profiles for adaptive 
speed during connected sessions. For a description see Appendix A

Preferences 

The way to find the preferences dialog 

Mbox 

The way to handle local messages on a server during a connected session 
By local messages we mean messages addressed to user@server. These messages are stored locally 
only, not forwarded to other PSKmail servers (now). The Mbox menu is only available when there 
are messages pending at the server. You can send mails addressed to a server by using the  

CALL @ SERVERCALL mail address.

Info commands

Get Messages

Fetch APRS messages for user stored at findu.com

Get tidestations

Get list of tidestations close to current position

Get tide(###)

Get tide data for tide station ###, use get tidestations to get number of 
the wanted tide station.
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Get Grib file

Here the client will send an email to query@saildocs.com requesting grib data, centered on your 
position +- 5 degrees. The server needs to know your return email address (send your mail record to 
the server if that has not been done). The grib file is delivered to your mailbox in the cloud. 
Download it and view the  file with 'ZyGrib”.

Get IAC Fleetcodes

This will query NOAA and fetch the IAC fleetcodes that produce a current pressure map for the 
north Atlantic. A file will be downloaded to the client and placed within ~/.pskmail/Downloads

You can view the file with zyGrib..

Get IAC forecast

This will query NOAA and fetch the IAC fleetcodes that produce a 24 hour forecast pressure map 
for the north Atlantic. A file will be downloaded to the client and placed within 
~/.pskmail/Downloads. ZyGrib is a good choice for viewing these files.

Get WWV

Get latest Geophysical Alert Message wwv.txt from NOAA.

Get APRS stations

Get a list of nearby APRS stations, uses clients reported position.

Get VHF/UHF Relays

Get VHF/UHF Relays from DARC.de centered at latest reported position.

Get camper sites

Get nearby camp sites from DARC.de. Works only in EU.

Get Server freqs

Get list of server frequencies entered at the PSKmail wiki (server page)

Get pskmail news

Get the latest pskmail news from the PSKmail wiki

Get web pages

Open the web page window where a web page can be requested from the server.

Identi.ca 

Send and get status updates for the PSKmail channel on Identi.ca. 

These updates will be sent to the PSKmail Identi.ca account so follow that to get the news.
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Link 

Here is where to handle the link to servers:

• Ping Send a ping frame on frequency Ctrl-P

• Inquire Send a ping to one specific server Ctrl-I

• Quality Show signal quality table on main terminal Ctrl-Q

• Link Send a link request to the server Ctrl-L

• Update Update server with your mail data record Ctrl-U

• Telnet Start the telnet agent Ctrl-T

Help 

Opens the interactive help which will be created from this manual and also displays license 
information about the application. 
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Mapping application

APRS information is mostly geographical by nature. Most often we transfer our 
position and while doing so others can and will receive that data. During a connected 
session we may ask about stations in the vicinity and the server will return a long list 
of stations with position attached.

The geographical data can be very useful as text but even more so when displayed on 
top of a nice map. JPSKmail includes a server socket that many APRS clients can be 
very easily connected to.

The APRS server is enabled within options, please have a look at the chapter here 
that deals with the devices tab. Just set that to enabled and select a port to use (or 
use the default 8063 which should be fine in most cases).

Beneath is an image where xastir, http://www.xastir.org/, is connected to jPSKmail 
running on the same computer. The procedure is simple, just ask xastir to connect to 
an internet server located on localhost at the port set within options (default is 8063).
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How to get weather information through PSKmail
This section is mostly intended for sailors but can of course be useful also for other purposes and 
situations. I am mostly writing as a sailor as that is the situation familiar to me. 

There are multiple ways to get weather information, there are also multiple ways of using this 
information and the intention here is to briefly talk about all of this. In no way is this the complete 
resource on how to do this as that would require several books or years of study.

The three main ways to get weather data at the moment is as clear human readable text (i.e. the 
weather report or forecast), IAC Fleet codes and grib files. The latter two are intended for use with a 
viewing tool.

There are also other possibilities, weather fax stations are available on the hf bands and a server 
sysop can set up a job that makes sure the latest report, forecast or image is available at the server 
all the time (contact the system operator for special needs).

Weather reports, the human readable kind

The main ways of getting these reports and forecasts are three:

1. Get a web page containing the necessary weather data

2. Download a file from the servers file area

3. Listen to a broadcast from a server

Fetch a web page

Getting a weather forecast from a web page involves a few steps. The first step is finding a reliable 
source web page to get data from. There are of course numerous sources for these and the PSKmail 
wiki is a good place to list the ones that work now. Here I will use BBC as an example, for instance 
the url: http://news.bbc.co.uk/weather/coast_and_sea/shipping_forecast/#area-4

As PSKmail is not a broadband connection to the internet its a good idea to limit the amount of data 
requested and just get the necessary text. By browsing this web page its easy to see that we can cut 
away things before and after the area we are looking for, for instance we can start getting the page 
from “general synopsis” and end at “Cromarty”. This way we can get just the part we are interested 
in. The web page request window can be prepared like the image below.
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When the web page bookmark has been prepared we are ready to connect to a server and push that 
button to request the page. When the server returns the requested page it will look like the example 
image below:

So, in summary what is needed to request a web page fetch of the weather forecast is:

1. Find a web page with a suitable weather forecast (look to the wiki for suggestions)

2. Prepare the web page request bookmark

3. Connect to a server and

4. During the connected session push the web page button and request the weather page.

Also, the email compression selector will affect the way web pages are fetched. If compression is 
enabled then the web page will be asked for in a zipped format (TGETZIP) and if not in clear text.

Download a file from the servers file area

Servers are connected to the internet and can fetch weather data periodically. This means that 
forecasts, warnings and even images etc. can be available on the server ready for download to the 
client. The server file area can be accessed during a connected session with a server. Connect to the 
server and select the Files tab. To see what files are available on the server just click on the List 
button. The server will respond with the current list of files, like the image below:

45



Files are listed with filename, date when it was last fetched and size in bytes.

The size part is important, get the bigger files when the connection is good.

To get one of the files just click on it to select it and then use the Download button located just 
above the text control. The client will then request the file from the server.

The available files and content will vary with the servers but some files will probably be available 
everywhere. Some of those include METAREA_I_WARNING, 
METAREA_I_HIGH_SEAS_FORECAST and METAREA_I_OFF_SHORE_FORECAST and 
these originate from the World Meteorological Organization, these and similar for other areas can 
be seen at http://weather.gmdss.org

Below is an image of what the warning file looked like when writing this chapter.

Getting IAC Fleetcode data

WMO FM 46, or IAC Fleet, are weather standard codes maintained by the World Meteorological 
Organization. These codes are designed for extreme brevity with mechanical typewriters or 
telegraphy operators in mind. The standard code is also very good in that its not a standard unique 
to only one country, language barriers can be overcome by using this common reporting standard.

These codes are indeed very compressed, the image further below came from a file with a size of 
only 3 kB. The codes themselves are sent as five number code groups and look like “66450 57368 
56367 54375 51388 49416 47448 46505...”

As can be seen above these codes are not easily read and to view them it is possible to plot and 
draw by hand but tools are available that do this. The image below is where this data is presented 
within the zyGrib software (which is free and available for multiple platforms).
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To get an updated IAC fleetcode file just connect to a server.
Locate the menu option “Get IAC Fleetcodes” within the Info menu and use it. That will have the 
server download a fleetcode file to your client. 

When done just close the connection and open the IAC fleetcode text file using an appropriate 
viewer (zyGrib for instance). The file is located within ~/.pskmail/Downloads. 
For users of other operating systems that “~” means the users home folder. On windows that could 
be something like: c:\documentsandsettings\users\per\pskmail\Downloads. Main thing is that its 
stored in your home folder.

Its also possible for the servers to broadcast this file on a regular basis, that way it will effortlessly 
just be there on the client without the need for a connect. How, when and perhaps even if the servers 
should broadcast is being discussed and investigated at the moment so this will have to be updated 
later. Broadcasts could be done at a different frequency, to minimize QRM to the APRS channel.

Getting grib files

Grib file (Gridded Information in Binary) are files used to store forecast information by National 
weather/meteorology Services. These files contain much more than the IAC Fleetcodes and so the 
files can be much, much bigger. But, they are also by most considered very valuable as they contain 
weather information (wind direction and speed) directly usable for navigation. Many electronic 
chart display systems can import these files and use them together with boat data to optimize the 
actual boat route. 

What you have to do to get them is the following:
* connect to a server
* once connected go to the Info menu and hit 'Get Grib File'

The client will send an email to query@saildocs.com requesting the data, centered on your position 
+- 5 degrees. For that the server needs to know your return address (send your mail record to the 
server if that has not been done) The grib file is delivered to your internet mailbox immediately.

* While still connected, hit the QTC button on the client (return email address has to be correct)
* The mail headers will be downloaded
* Click on the header containing your grib file
* The server now sends the grib file to your client (using ARQ, so no errors)
* When download is ready you can view the attachment with zyGrib.
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So summing it up:

Connect the the server, request the grib file, download the grib file and view the grib file with 
zyGrib or another viewer for grib files. The attached file will be placed within the Files folder 
within the pskmail directory (~/.pskmail/Files on linux).
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Appendix A, Mode selection
This table tries to gather data about the data modes that are usable with pskmail. Its important to 
note that this is an attempt and a work in progress, test results and data that can be used to enhance 
this table is most welcome!

Anyway, a few facts and conclusions can be drawn from this table:

–The fastest mode is PSK500, live tests have shown speeds of 1862 char/min with ARQ.

–The fastest mode for US hams on HF is PSK250

–The slowest mode here is THOR 8 at 28 wpm

–The most narrow mode is PSK63, 63 Hz wide

You may notice that certain popular modes are missing from this table. Two of the missing modes 
are Olivia and MT63. Olivia is not usable with pskmail as it doesn't support the full 8-bit character 
set, that means the <SOH> frame start and <EOT> frame end cannot be transferred.

Mode tables for adaptive asymmetric link control

As from jPSKmail version 0.5, separate adaptive mode control for up- and downlink modes is 
automatic.

To accomplish this a number of changes to server and client were necessary. John, VK2ETA has 
played an important role herein.  The mode table can now be set in the client, and the server will 
follow this table. Separate RX and TX modes and speeds can be set for the connect sequence, the 
server will change the modes according to the channel condition.

The table  incorporates the most popular modes, covering a large range of speeds, sensitivities and 
robustness (qrm, Doppler, multipath). 
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Choice (1-3) for
Baud Speed wpm Speed wpm Speed* Bandw. SNR Weak High Flutter,

Mode rate capital letters small letters bps (hz) at least NVIS signals Speed fading Description and use
PSK63 63 74 102 88 63 -2 3 3 3 3 Vy narrow bt also vy slow
PSK125 125 148 204 176 125 -1 3 3 3 3 Better
PSK250 250 296 408 352 250 -1 3 3 2 3 Good all round mode
PSK500 500 592 816 704 500 2 3 3 1 3 Very fast, best 4 good condx

PSKR125 125 74 102 88 125 -8 2 2 3 2
PSKR250 250 148 204 176 250 -5 2 2 2 3
PSKR500 500 296 408 352 500 -3 2 3 1 3 Best allround mode?

MFSK16 15,6 58 58 58 316 -8 1 1 3 1
MFSK32 31,25 120 120 120 630 -6 1 1 2 1

Dominoex 11 10.8 70 70 70 262 -7 3 2 3 3 fldigi implementation flawed?
Dominoex 16 15.6 100 100 100 355 -6 3 2 3 3 fldigi implementation flawed?
Dominoex 22 21.5 140 140 140 524 -5 3 2 2 3 fldigi implementation flawed?

THOR8 7.8 28 28 28 346 -6 1 1 3 2
THOR11 10.7 40 40 40 262 -5 1 X 3 2
THOR16 15.6 58 58 58 355 1 X 3 2
THOR22 21.5 78 78 78 524 1 X 2 2

* Speed is an attempt. Varicode and different ways to measure makes this difficult
** SNR is whatever I could find, most at 3 Khz bandwidth..



Possible mode table:

PSK500 – PSK500R – PSK250R –  THOR22 – MFSK16 – THOR8 - THOR4

The modes in these tables run from fast to slow, and become more robust and sensitive from right to 
left. The server knows the S/N ratio and the download success rate in the client, and chooses the 
modes which allow the best throughput for the present channel conditions. Initial tx and rx modes 
are set on the client prior to issuing a connect frame. This is (still) under operator control. 

Before sending a frame the server decides if a mode  change is possible (up) or necessary (down) 
based on the S/N ratios of both links and arq success history. In that case the server switches one 
position up or down in the table.

APRS Mode choice

For the APRS functions the best mode is normally the default channel mode. In Europe this is 
PSK500R.  US servers will use PSK250, unless they operate on MARS frequencies.

In case a station does not come through in the default mode it is possible to use a lower speed mode 
with RSID on. TX RSID can be switched on manually in fldigi. On receipt of a QSL from a server 
the client's TXID will automatically be switched off again. This to prevent mode chaos on the 
frequency... 

Squelch Control

The squelch in fldigi is controlled by the jPSKmail client. The squelch level is automatically set to 
match the operation mode. If the squelch is switched off inadvertently, jPSKmail will automatically 
switch it back on. Without squelch operation the DCD function does not work, and the client cannot 
send beacons if the squelch is open...
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Appendix B:

PSKmail ARQ protocol specification (3rd draft)

Introduction

PSKmail is an ARQ data transmission system. It has been optimized for use on 
short wave (HF) radio frequencies. PSKmail has both a client/server 
architecture and a client/client architecture. The servers are gateways to 
diverse services on the internet. The clients enable mobile or portable radio 
stations to access the internet where there is no other coverage, or send 
messages and files to each other.

To use PSKmail, one uses a short wave radio and a PC with a sound card, and 
often a hardware interface between the radio and the PC. The communications 
protocol has been optimized for the specific conditions on short wave:

● Varying propagation conditions on short wave, with multi-path, doppler 
effects,  and often weak signals near the noise floor.

● Often the mobile stations run low power and compromise antennas.
● As ham radio uses shared frequencies, interference levels are high.

To cater for this wide range of conditions, PSKmail does not use a single digital 
radio mode. Instead it uses a range of modes with separate adaptive control 
on up- and download channels. The maximum bandwidth of the HF system 
is 500 Hz, and speeds range from 44 CPS for ideal channels down to 2 CPS for 
the most problematic ones. For clean (single hop) channels PSK modes are 
used, for fuzzy channels MFSK and THOR modes are employed, including 
convolutional coding, Viterbi decoders, and interleavers to counteract static 
noise...

Radio interface

The radio is always used in USB mode, as several of the modes used are 
polarized. THOR modes, e.g., are derived from DominoEx. Often a hardware 
interface is needed between modem and radio, to provide galvanic isolation for 
audio signals and PTT signal. The protocol timing also allows the use of VOX.

Modem interface

PSKmail uses Fldigi (>= 3.20) as a modem, which is a multi-mode digital 
modem program using the computer sound card. PSKmail uses ASCII 
characters 0x01 (<SOH>, 0x04 <EOT>, 0x06 <ACK>, 0x12 <DC2> and 
printable ASCII characters 32 ... 127 to talk to the modem. 
The system uses RSID signalling to notify the link layer protocol engine of 
mode changes, and also makes signal/noise ratio data available to the 
application.
PTT signalling is generated by Fldigi.
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The modem program is available for all operating systems.

Link layer protocol

The PSKmail system uses a master/slave protocol. The server is the master, the 
client is the slave. In case two clients connect each other for a TTY (chat) 
session, the caller is the slave. 
All control functions are in the master, which makes timing a lot easier than in 
the first PSKmail implementations, where client and server would compete until 
they were transmitting synchronously on top of each other. 

Status diagram

Protocol details

All transactions between server and client are packed in frames. Every frame 
consists of maximum 18 blocks, viz. 0 ... 16 data blocks, 1 status block,  and 1 
optional identification block (at start of session and every 10 minutes 
thereafter).
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Frame structure:

<SOH>[<ident block>]<data block>... <data block><status block><EOT>

All blocks have the same structure. They contain a header, a data partition, and 
a CRC16 number. The start of a block is marked with a <SOH> (ASCII 0x01) 
character. A status block ends with a <EOT> (ASCII 0x04) character. The data 
partition can be 0 ... 64 characters long.

Block structure:

<SOH><header><data><CRC> 
or
<SOH><header><data><CRC><EOT> (status block)

The header consists of 3 characters. The meaning of these characters is 
different for master (server) and slave (client), and also depending on block 
type. For the client header: 

Block type Character 1 Character 2 Character 3

Status Rx s/n [0x20 - 0x7A] Session [0x20 - 0x5F] s

Data 0 Session [0x20 - 0x5F] Blocknr. [0x20 - 0x5F]

Connect Protocol version [0,1] 0 c

Summon Protocol version [0,1] 0 n

Abort 0 Session [0x20 - 0x5F] a

Ident 0 Session [0x20 - 0x5F] i

For the server header:

Block type Character 1 Character 2 Character 3

Status Next Txmode [0 -8] Session [0x20 - 0x5F] s

Data 0 Session [0x20 - 0x5F] Blocknr. [0x20 - 0x5F]

Connect ack Protocol version [0,1] Session [0x20 - 0x5F] k

Disconnect 0 Session [0x20 - 0x5F] d

Ident 0 Session [0x20 - 0x5F] i

Some blocks have a fixed data field:

Block type Data partition 

Connect PI4TUE:24  PA0R:1024 xyyyy  (x = 0 – 8, initial server TX mode)
                                               (yyyy = mode table)

Connect ack PA0R:1024 PI4TUE:24 x  (x = block data length)

Summon PI4TUE:24 PA0R:1024 10146000 x ( x= 0 – 8, initial server TX mode)

Ident PA0R de PI4TUE 
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ARQ control and repeats

The receive buffer is a circular buffer with room for 64 blocks. The status 
block  data field carries  the status of the receive buffer:

Char 1 Char 2 Char 3 Chars 4-12

Last block sent 
this frame

Buffer o.k. 
until/incl. block x

Last good block 
received

Missing blocks

[0x20 - 0x5F] [0x20 - 0x5F] [0x20 - 0x5F] 0 -8 x [0x20 - 0x5F]

Missing blocks are repeated by adding them to the next frame.

Adaptive mode control

The server controls both its own digital mode and that of the client.

The mode table covers a broad range of speeds and modes:

PSK500 PSK500R PSK250R MFSK32 THOR22 MFSK16 THOR8
For use in USA , where Baud rates over 300 Baud are not allowed on ham radio 
frequencies below 30 MHz, an alternative mode table is available:

PSK250 PSK250R PSK125R MFSK32 THOR22 MFSK16 THOR8
In client version 1.5.6 and server version 1.5.1 THOR4 has become available.

Both client and server measure S/N ratio of the frame received, and the client 
sends its SNR data to the server in every status block. The server signals mode 
changes to the client via RSID and through a flag in its status block header.

If a status block is not received, a poll frame is sent, which is  just an empty 
frame  without data blocks.

TX and RX modes are controlled in such a way that the number of ARQ repeats 
are limited, providing optimum throughput for the relative channel.

The server uses RSID on receive, so the client can connect in any of the 
available modes. Default listening mode is PSK500R, but the server can scan 
more sensitive  modes for DX if necessary.

Mode indicators for sending the Mode table to the server:

1 2 3 4 5 6 7 8 9 a b c e
THOR
8

MFSK
16

THOR
22

MFSK
32

PSK
250R

PSK
500R

PSK
500

PSK
250

PSK
125

PSK
63

PSK
125R

MFSK
64

THOR
4

Squelch Control

Squelch level is automatically adjusted to a proper value  by the client, to 
match the relevant operating mode.

Compression techniques

The PSKmail server uses gzip to compress web pages, emails and binary files. 
This zipped image is then Base64 coded for transmission with the ASCII127 
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character set. Coding and decoding are automatic.

Unproto (non-ARQ) operation

There are 4 PSKmail functions which use unproto frames. These functions are:
● Ping
● Inquire
● Link to server
● APRS Beaconing and Messaging

Like ARQ frames, unproto frames consist of a header,a data field and a CRC.
When the client sends a Ping or Inquire frame, all servers answer with a 
Ping reply frame. The Ping reply frame contains a signal quality indication 
representing the RX signal quality in % at the server.

Ping frame <SOH>00uPA0R:7 ABCD<EOT>

Inquire frame <SOH>00uPA0R:8 PI4TUE  ABDD<EOT>

Ping reply frame <SOH>PI4TUE:71  99 BCDA<EOT>

Every PSKmail server has a link table containing client calls. A client can only 
be in the link table of 1 server. This function is used when the server sends an 
APRS message to a specific client. This way, the message is only sent by one 
server.
The client sends a link request to a specific server, and on receipt of the 
request the server acknowledges the request:

Link request <SOH>00uPA0R><PI4TUE ABCD<EOT>

Link acknowledge <SOH>00uPA0R<>PI4TUE ABCD<EOT>

The server and the client can send a beacon on HF, containing its APRS 
position and a status message:
Server beacon: <SOH>00uIS0GRB-3:72 Pskmail_Server_0.9.34-10147.0KHz  -DD6E<EOT> 

Client beacon <SOH>00uIK2YXT:26 !4507.95N/01044.65E-I1B80<EOT>

When the server hears a client beacon or an APRS message, it confirms 
reception with a short QSL message. The QSL message contains a signal 
quality indication (%):
QSL message <SOH>QSL PA0R de PI4TUE  99 555F<EOT>

An APRS message has the same format as the client beacon, an APRS email 
starts with an address@something.xxx .

APRS 
message

<SOH>00uDJ0LN:26 PA0R This is the APRS message 1B80<EOT>

APRS email <SOH>00uDJ0LN:25 PA0R@ISP.ORG This is the email message 2A97<EOT>
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CQ <SOH>00uPA0R:27 CQ CQ CQ PSKmail 02B2<EOT>

RSID signalling

RSID (Reed Solomon Identification) is used for mode change signalling. Thereby 
the following rules are applied:

TX RSID RX RSID

Client Idle (APRS) OFF OFF (manual switch ON)

Client receives acknowledge OFF OFF

Client connect request ON ON

Client data transfer OFF ON

Server Idle (APRS) OFF ON

Server sends acknowledge ON ON

Server data transfer OFF OFF

Server changes mode ON OFF

Client 1.5.6 uses TXID ON more often on slow modes like THOR8 and THOR4.
This to enhance the robustness of the mode change protocol.
Also block size and blocks per frame are lowered using the slow modes.

56



References

MFSK modes http://www.qsl.net/zl1bpu/MFSK/

PSK modes http://aintel.bi.ehu.es/psk31.html

Fldigi descriptions http://www.w1hkj.com/FldigiHelp-3.12/Modes/psk.htm

http://www.w1hkj.com/FldigiHelp-3.12/Modes/mfsk.htm

http://www.w1hkj.com/FldigiHelp-3.12/Modes/thor.htm

Fldigi http://www.w1hkj.com/beginners.html

PSKmail: http://www.pskmail.org/

Mailing list: http://www.freelists.org/archive/pskmail

REV.8  Authored by: Per Crusefalk & Rein Couperus, PA0R, 02-03-2012

57

http://www.freelists.org/archive/pskmail
http://www.pskmail.org/
http://www.w1hkj.com/beginners.html
http://www.w1hkj.com/FldigiHelp-3.12/Modes/thor.htm
http://www.w1hkj.com/FldigiHelp-3.12/Modes/mfsk.htm
http://www.w1hkj.com/FldigiHelp-3.12/Modes/psk.htm
http://aintel.bi.ehu.es/psk31.html
http://www.qsl.net/zl1bpu/MFSK/

	Preface
	A brief attempt at writing the history of the project
	What is PSKmail?
	So, what makes PSKmail special?
	In summary, what is pskmail?
	What about security in pskmail?
	Installation and getting started
	Install procedure
	Optional aprs mapping client
	Installation Instructions for RXTX
	Windows 98/NT/2000/XP:
	Linux:
	Others, manual procedure


	Hardware selection
	Transceiver
	 Soundcard interface
	Antenna
	Setting up Fldigi
	Carrier frequency (Hz)
	AFC range (Hz)
	Reset to Carrier and Report ARQ frames average S/N
	RS ID


	User Interface tour
	Preferences window
	User data
	Sending the link password to the server
	Beacon minute and server channel
	Choosing the appropriate modes
	Setting the Mode table and the default mode
	Setting operating modes
	Email settings
	Configuration Terminal tab, connected operation (ARQ)
	Devices
	Modem
	Running fldigi and jPSKmail on separate PC's

	Main user interface, tabs
	Terminal tab, connected operation (ARQ)
	
Terminal tab, chat mode (ARQ)
	Composing an email
	Preparing an email
	Sending email, connected
	PSKaprs emails
	Receiving email

	Mail headers tab
	Mail tab buttons
	Files tab (connected mode)
	APRS tab, Unconnected Operation

	Bulletin reception mode
	Bottom part of the client
	Status Line, Monitor mode
	Status Indicators

	Modem tab
	Igate Tab
	Rig control tab
	Main menu
	File 
	Mode 
	Preferences 
	Mbox 
	Info commands
	Get Messages

	Fetch APRS messages for user stored at findu.com
	Get tidestations

	Get list of tidestations close to current position
	Get tide(###)

	Get tide data for tide station ###, use get tidestations to get number of the wanted tide station.
	Get Grib file

	Here the client will send an email to query@saildocs.com requesting grib data, centered on your position +- 5 degrees. The server needs to know your return email address (send your mail record to the server if that has not been done). The grib file is delivered to your mailbox in the cloud. Download it and view the  file with 'ZyGrib”.
	Get IAC Fleetcodes
	Get IAC forecast
	Get WWV

	Get latest Geophysical Alert Message wwv.txt from NOAA.
	Get APRS stations

	Get a list of nearby APRS stations, uses clients reported position.
	Get VHF/UHF Relays

	Get VHF/UHF Relays from DARC.de centered at latest reported position.
	Get camper sites

	Get nearby camp sites from DARC.de. Works only in EU.
	Get Server freqs

	Get list of server frequencies entered at the PSKmail wiki (server page)
	Get pskmail news

	Get the latest pskmail news from the PSKmail wiki
	Get web pages

	Open the web page window where a web page can be requested from the server.
	Identi.ca 
	Link 
	Help 

	Mapping application
	APRS information is mostly geographical by nature. Most often we transfer our position and while doing so others can and will receive that data. During a connected session we may ask about stations in the vicinity and the server will return a long list of stations with position attached.

The geographical data can be very useful as text but even more so when displayed on top of a nice map. JPSKmail includes a server socket that many APRS clients can be very easily connected to.
	The APRS server is enabled within options, please have a look at the chapter here that deals with the devices tab. Just set that to enabled and select a port to use (or use the default 8063 which should be fine in most cases).
	Beneath is an image where xastir, http://www.xastir.org/, is connected to jPSKmail running on the same computer. The procedure is simple, just ask xastir to connect to an internet server located on localhost at the port set within options (default is 8063).
	How to get weather information through PSKmail
	Weather reports, the human readable kind
	Fetch a web page
	Download a file from the servers file area

	
Getting IAC Fleetcode data
	Getting grib files

	What you have to do to get them is the following:
	* connect to a server
* once connected go to the Info menu and hit 'Get Grib File'
	The client will send an email to query@saildocs.com requesting the data, centered on your position +- 5 degrees. For that the server needs to know your return address (send your mail record to the server if that has not been done) The grib file is delivered to your internet mailbox immediately.
	* While still connected, hit the QTC button on the client (return email address has to be correct)
* The mail headers will be downloaded
* Click on the header containing your grib file
* The server now sends the grib file to your client (using ARQ, so no errors)
* When download is ready you can view the attachment with zyGrib.

	So summing it up:
	Appendix A, Mode selection
	Mode tables for adaptive asymmetric link control
	APRS Mode choice
	Squelch Control

	Appendix B:
	PSKmail ARQ protocol specification (3rd draft)
	Introduction
	Radio interface
	Modem interface
	Link layer protocol
	Status diagram
	Protocol details
	ARQ control and repeats
	Adaptive mode control
	Mode indicators for sending the Mode table to the server:
	Squelch Control
	Compression techniques
	
Unproto (non-ARQ) operation
	RSID signalling

	References


